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Preface

Thank you for selecting the MONITOUCH V6 series.

For proper set-up, you are requested to read through this booklet to understand more

about the product.

For more information about V6 series, refer to the following manuals.

For  further details about the PLC, see the manual attached to each PLC.

Notes:

1. This booklet may not, in whole or in part, be printed or reproduced without the prior

written consent of Hakko Electronics Co., Ltd.

2. Information in this booklet is subject to change without prior notice.

3. This booklet is intended to give information about MONITOUCH hardware.





In this "Specifications for V608CH", you will find various notes categorized under the following

three levels with the signal words "Danger," "Warning," and "Caution."

These signal words are to warn the user of possible misuse of the unit.  To comprehend the

critical notes on the safe procedure, you must go through this manual before you install

MONITOUCH and operate it correctly.

DANGER

Danger
indicates an imminently hazardous situation which, if not
avoided, will result in death or serious injury.

Notes on safe usage of MONITOUCH

WARNING
Warning
indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

Caution
indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury and could
cause property damage.

CAUTION



Notes on System Design

Notes on Installation

Never use the input function of MONITOUCH such as the touch switch

for an emergency switch because it could threaten a human life or

break a part of the unit.

Please design the system of the unit in order to respond to a malfunction

of the touch switch.

Operate MONITOUCH under the conditions indicated by the manual.

Never bundle input/output cables with high-voltage and large-current

cables such as power supply cables.  Keep input/output cables at least

200mm away from power supply cables in order to avoid malfunction

caused by noise.

WARNING

CAUTION

CAUTION
If you don't set the conditions indicated by the manual for the unit, it

could cause fire, malfunction, physical damage or deterioration.

Maintain the following conditions in order to avoid fire or trouble.

Don't let the unit come in contact with corrosive gas, flammable

gas, solvents, grinding fluids or cutting oil.

Never let the unit be exposed to high temperature, high humidity,

and other outside weather conditions.

Don't allow the unit to be exposed to excessive dust, salt, and

metallic particles.

Don't allow the unit to be shaken or hit by other objects.

Equipment must be correctly mounted so that the main terminal will

not inadvertently be touched during an application.

As for the use in the facilities related to nuclear energy or in the facilities

of official importance, please consult with our distributer about it.



Turn off the power supply when you set up the system or connect the

cables, otherwise you will get an electric shock or damage the unit.

Never touch the terminals while the power supply is on, otherwise

you will get an electric shock.

Notes on Cable Connection

Notes on Maintenance and Operation

Connect the cables correctly to the terminals of MONITOUCH in

accordance with the specified voltage and wattage. Over-voltage, over-

wattage and the incorrect cable connection could cause the unit to be

damaged physically or functionally and also could result in fire.

You must put the cover of the terminals on the unit when you turn on

the power and operate it.

DANGER

DANGER

CAUTION

Prevent any conductive particles from entering into MONITOUCH.

The conductive particles could cause fire, trouble, or malfunction of

the unit.

Ground FG terminal which must be for the unit.   The level of grounding

resistance is less than 100Ω.

The liquid crystal in the LCD panel is a hazardous substance.  If the

LCD panel is damaged, never swallow the leaked liquid crystal.  If the

liquid crystal spills on your skin or clothing, use soap and wash off

thoroughly.



CAUTION

Hakko Electronics Co.,Ltd. is not responsible for an unauthorized

person who may fix, disassemble, or reconstruct any unit.

Switch resolution of the MONITOUCH

V608CH is determined by the analog-

type resistance film.  Do not press two or

more positions on the screen at the same

time.

If two or more positions are pressed at

the same time, the switch located between the pressed positions

activates.  Please take note of this.

Avoid displaying the same patterns for hours.

It may cause afterimages due to the property of LCD display.  If you

use the fixed patterns for hours, use the auto-OFF function of the

backlight.

F1

F2

F3

F4

F5

F6

F7

SYSTEM

POWER

switch

  Pressing two positions at the same time
activates the switch in the center.
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Features1
1) Handy-sized, Portable Unit

A slim, space-saving design makes the unit easily portable.  It can be set up as either a wall-mount or

desktop unit using the dedicated mounting hardware (optional; V6H-WF) or stand (optional; V6H-ST).

2) 128 Colors Displayable on the 7.7-inch LCD

Equipped with a high-intensity, high-resolution 7.7-inch STN color LCD, rich color display becomes

possible on the 128-color V6 series screen.  Bitmap files can also be displayed in extremely high quality.

3) VGA Display

A high-resolution VGA (640 dots by 480 dots) display is used.  More information can be displayed on the

screen.

4) Safety Function

A push-lock-type emergency stop switch (forced open-circuit mechanism) is provided as standard.

Also, to prevent misoperations, a deadman switch (3-position switch available as an option) is provided.

It is possible to implement increased security by adding a key switch (optional) that restricts the operation

only to the person who has the relevant key.

5) CF (Compact Flash) Card Supported

V6 series supports large-capacity CF cards.

• Saving screen data and system programs

Since multiple screen data can be saved, it is possible to exchange screen data in the field.

• Saving memo pads

Data in memo pads can be saved.  Saved files can be converted into bitmap files using CF Card

Manager included in V-SFT Editor.

• Saving patterns

Patterns that are used for screens can be saved on the CF card.  It is possible to save memory for

screen data.

• Saving hard copy image as a file

Screen display can be saved as a file using the macro command.

Also, it is possible to convert it into a bitmap file using CF Card Manager included in V-SFT Editor.

• Reading and writing CSV files

CSV files can be imported into V608CH using the macro command.  Data in the PLC memory or V6

internal memory can be output to a CSV file.

• Sampling function

Sampling data can be saved on the CF card.  Sampling data can be converted into a CSV file using the

macro command, which enables data editing on the computer.

1. Features
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Notes on Usage2
Environmental Limits

1. Use MONITOUCH at an ambient temperature of

0~50˚C, and a relative humidity of 85 %RH.

2. Avoid places where moisture may easily

condense due to sudden temperature changes.

3. Avoid direct sunlight.

4. Never install MONITOUCH in a place where

impacts or vibrations may be transmitted.

1. Notes on Usage

5. Avoid any place in which there is the possibility

that water, corrosive gas, flammable gas,

solvents, grinding fluids or cutting oil can come

in contact with the unit.  Never install the unit in

a place where dust, salt and metallic particles

are present.

Locations

1. Secure sufficient space around MONITOUCH for

ventilation.

2. Never attach MONITOUCH to the top of any

apparatus generating high levels of heat (heater,

transformer, large-capacity resistor, etc.).

3. Never install MONITOUCH in the same

compartment as high-voltage equipment.  The

unit should be at least 200 mm away from

highvoltage lines or power cables.
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1 - 31. Notes on Usage

Usage

1. An emergency stop circuit must be composed of

an external relay circuit with a start signal for

MONITOUCH built in.  Do not create switches

on MONITOUCH to be used in case of emer-

gency.

2. MONITOUCH has a glass screen.  Never drop

or subject the unit to strong impacts.

3. In a dry environment, MONITOUCH may

generate a large amount of static electricity.

Therefore, before touching the unit, touch a

grounded metallic section to discharge the static

electricity.

4. Application of thinner may discolor

MONITOUCH.  Use alcohol or benzine available

commercially for cleaning.

5. Never remove any printed circuit board from

MONITOUCH.  (This will harm the unit.)

6. Never operate the display by using a tool with a

sharp point like a screwdriver.

Touch the display by fingers.
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Deadman switch Key switch

0 momentary w/o

1 momentary with

2 3-position w/o

3 3-position with

RESET

disc

POWER

SW1
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SW3

SW2
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F4

SYSTEM

ENB

run

V6

V6-CP

16MBCompactFlash

CF Card

Personal Computer (PC)
V-SFT

RS-232C/RS-422

Panel Editor
for V series

Creating screens

Universal-purpose
computer

RS-232C/RS-422

Link Unit

Transferring
screen data

V6-BCD

Barcode Reader

During operation
(Universal serial
 communication)

During operation
(Link communication)

Cable

Transferring
screen data
etc.

System Composition3
System Composition / Model Indication / Peripheral Equipment / Recommended CF Cards

System Composition

The following illustration shows possible system configurations using V608CH.

List of Models

The characters on the right of model names represent optional features and special specifications.

1. System Composition

Danny
文字方塊
V608CH1-027      與標準品不同在於，沒有緊急停止開關，不附帶使用環境說明書
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Peripheral Equipment

The following options are available for V6 series.

V-SFT

Application software for editing screen data

(for Windows98/NT4.0/Me/2000/XP)

V6-CP (data transfer cable) 3 m

Connects V6 to a personal computer.

1. System Composition

V6H-C  (external connection cable)

 : 3, 5, 15, 20 (m)

30-wire cable for PLC communication or power supply

V6H-ST (desktop stand)

Stand for desktop use.  The vertical angle can be set as desired.

V6H-WF (wall-mount bracket)

Mounting bracket for wall-mount use.  Two pieces (one for the V6 and the

other for the wall) makes a set.

* This wall-mount bracket cannot be used if the modular jack is in use.

V6H-WF1 (wall-side piece of wall-mount bracket)

Mounting bracket for wall-mount use.  This is the piece to be mounted on

the wall.

* This wall-mount hardware cannot be used if the modular jack is in use.

V608C-FL (backlight)

V608H backlight for replacement
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GD

G
P
P V-MDD

1 2 3

V6H-RB (battery)

Backup battery for the built-in clock

V-MDD (ACPU/QnACPU/FXCPU dual port interface)

Add-on connector with two ports, specifically designed for the connector

on Mitsubishi's ACPU/QnACPU/FXCPU programmer.  This interface can

be used when connecting V6 series directly to Mitsubishi's ACPU/

QnACPU/FXCPU programmer.

+
SANYO M

n
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iCELL3VOLTS
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Recommended CF Cards

The recommended CF cards are shown in the following table.

Manufacturer

Kodak

SanDisk

I•O Data Device

Type

KPCN-32

SDCFB-64-505

SDCFB-xxxx-801

CFS-32MA

CFS-xxM(HI)

Capacity

32MB

64MB

32MB

64MB

96MB

128MB

192MB

256MB

384MB

512MB

1GB

32MB

32MB

64MB

128MB

256MB

512MB

Manufacturer

I•O Data Device

Hagiwara Sys-Com

MELCO

Type

CFS-iVxxx

HPC-CFxxZX

RCF-xx

Capacity

32MB

64MB

128MB

256MB

512MB

32MB

64MB

128MB

256MB

512MB

V6-BCD (barcode reader cable) 3 m

Connects V6 and a barcode reader.

1. System Composition

V6-TMP (V-link cable) 3 m

Connects V6 and a personal computer (PLC).
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1. Deadman switch

/ 3-position switch (Option)

2. Emergency stop switch

3. ENB lamp

4. Function keys (refer to P2-16)

5. Output switches

6. Display

7. Power lamp

8. Key switch (Option)

9. TB1 : Terminals for PLC communication,

power supply and output (to outside)

10. MJ1 : for data transmission

11. SW1 : Terminal resistance (upper:on)

12. Mounting holes for cable clamp and neck strap

13. Mounting holes for bracket (V6H-WF : option)

14. Connector for battery (V6H-RB : option)

maintaining the data of built-in clock

15.  I/F cover

Front Side

Rear Side

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

TB1 MJ1

S
W

1

CURRENT : 0.4A
INPUT : 24VDC

TYPE : V608CH
LOT No. :

MADE IN JAPAN
Hakko Electronics Co., Ltd. 

Side Bottom

Names of Components4
1. Names of Components

16. CF card interface

17. Mounting hole for communication cable
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Dimensions5
1. Dimensions

Dimensions of V608CH

106
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CURRENT : 0.4A
INPUT : 24VDC

TYPE : V608CHD
LOT No. :

MADE IN JAPAN
Hakko Electronics Co., Ltd. 

47
24

259

23
2

Top view

Front viewSide view

Bottom view

Rear view

Unit : mm

OFF ON
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Item

Type

Rated Voltage

Permissible Range

                          of Voltage

Permissible Momentary Power Failure

Demand

Rushed Electric Current

With-stand voltage

Insulation Resistance

Ambient Temperature

Storage Ambient Temperature

Ambient Humidity

Dust

Solvent Resistance

Corrosive Gas

Vibration Resistance

Shock Resistance

Noise Resistance

Static Electricity Discharge Resistance

Grounding

Structure

Cooling System

Weight

Dimensions W X H X D (mm)

Case Color

Material

Approx. 1.2kg

  259 X 232 X 47 (Excluding Emargency switch)

Protection structure: complies with IP65 (when using I/F cover)
excluding V608CH2, V608CH3

Form: in a body
Mounting procedure: Hold, Hang, Stand

V608CH

DC external terminals to FG : 500V AC per min.

500V DC, 10M    or more

0    ~+50    

-10    ~+60

85% RH or less (without dew condensation)

No conductive dust

No cutting oil or no organic solvent to cling to the unit

No corrosive gas

Vibration frequency: 10~150Hz, Acceleration: 9.8m/s  (1.0G)

3 directions of X, Y and Z: one hour

Pulse shape: Sine half wave,

Peak acceleration: 147m/s  (15G), 3 directions of X, Y and Z: six times

Noise voltage: 1000Vp-p, noise width: 1   s

Contact: 6kV , Air: 8kV

Grounding resistance: less than 100

Cooling naturally

24V DC

24V   10% DC

within 10ms (24VDC)   

2

2

20W or less

13A

2ms

Equivalent to the Munsell color system N-2.0 (Black)

PC/ABS

1. Specifications

General Specifications
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Display Device

Resolution W X H (dots)

Dot Pitch W X H (mm)

Effective Display

Color

Backlight

Average Backlight Life

Auto Light OFF Function

Contrast Adjustment

POWER Lamp

ENB Lamp

Surface sheet

*

Item Specifications

* Room temperature of 25 C is assumed.
  The backlight life is regarded as expired when brightness is decreased to 50% of the initial level.  

STN color LCD

640 X 480

0.082 X 0.246

Size 7.7 inches

128 colors + 16 blink colors

Cold-cathode tube (replaceable by the user)

Approx. 40,000 h

Always ON / Auto OFF 

Adjustable with a function switch

ON when the power is on

ON when the screen is operable

Material : PET

Number of Switches

Switch Type

Average Mechanical Life

12 (4: external direct output)

Membrane switch

1 million actuations or more

Item Specifications

1024 (W) X 1024 (H)

Analog resistance film

1 million actuations or more

Hard-coated, 5% non-glare treatment 

Item

Switch Resolution

Type

Average Mechanical Life

Surface Treatment

Specifications

Number of Switches

Type

Average Mechanical Life

Rating

1

Push-lock type (2 "b" contacts, common)

100 thousand actuations or more

Rated using voltage 24V Resistance load 1.0A

Item Specifications

1. Specifications

Display Specificarions

Touch Panel Specifications

Function Switch Specifications

Emergency Stop Switch Specifications
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Number of Switches

Number of Contacts

Average Mechanical Life

Average Electrical Life

Rating

1

1 "a" contact

250 thousand actuations or more

100 thousand actuations or more (open/close frequency: 1200 times/h)

Rated using voltage 24V Resistance load 1.0A

Item Specifications

Number of Switches

Number of Contacts

Average Mechanical Life

Operating Pressure (Reference)

1

1 “a” contact (double interrupt, slow action)

1 million actuations or more (1P   2P   1P)

100 thousand actuations or more (1P   2P   3P)

Pressure required for direct circuit actuation: 30 N or more

Item Specifications

RS-232C, RS-422/485

Asynchronous mode

Data length: 7, 8 bits

Parity: even, odd, none

Stop bit: 1, 2 bits

Baud rate: 4800, 9600, 19200, 38400, 57600, 76800, 115200 bps

RS-232C

Data length: 7, 8 bits

Parity: even, odd, none

Stop bit: 1, 2 bits

Baud rate: 4800, 9600, 19200, 38400, 57600, 76800, 115200 bps

8-pin Modular Jack (MJ1)
  Screen data transfer
  V-Link
  Barcode

* I/F cover or wall-mount 
hardware unusable

Item Specifications

Multi-step Terminal Block (TB1)
  PLC connection
  Power supply
  External output

Number of Switches

Type

Average Mechanical Life

1

Momentary type (1 "a" contact)

1 million actuations or more

Item Specifications

1. Specifications

Deadman Switch Specifications

3-position Switch Specifications (Optional)

Key Switch Specifications (Optional)

Interface Specifications
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             Item

Editing Method

Editing Tool

                                              Specifications

Exclusive editing software

Name of exclusive editing software     : V-SFT (ver.1.2.18.0 or later)

Personal computer     : Pentium ll 450MHz or more is recommended

OS     : Microsoft Windows 98/Me/NT version 4.0/2000/XP

Capacity of hard disk required     : free area of approx. 460MB or more

Display     : Resolution of 800 X 600 or more is recommended

                  Item

Display Language*

Characters

Size of Characters

Number of Characters

Property of Characters

Kind of Drawing

Property of Drawing

1/4-size : 8 X 8 dots

1-byte   : 8 X 16 dots

2-byte   : 16 X 16 dots or 32 X 32 dots

Enlarge : W, 1-8   H, 1-8

Lines : line, continuous lines, box, parallelogram, polygon

Circles : circle, arc, sector, ellipse, elliptical arc, elliptical sector

Others : tile patterns

Type of lines : 6 types (fine, thick, dot, chain, broken, two-dot chain)

Tile patterns : 16 types (incl. user-definable 8 types)

Display property : normal, reverse, blinking

Display color : 128 colors + blinking 16 colors 

Color specification : foreground, background, boundaries (line)

Specifications

1/4-size, 1-byte

2-byte (16-dot)

2-byte (32-dot)

Japanese

ANK code

JIS 1st and 2nd

JIS 1st

Eng./W. Europe

Latin 1

Chinese

ASCII code

Chinese

Chinese (simplified)

ASCII code

Chinese (simplified)

Korean

ASCII code

Hangul (without Kanji)

         640 X 480

80 columns X 60 lines

80 columns X 30 lines

40 columns X 30 lines

Resolution

1/4-size

1-byte

2-byte

Display property : normal, reverse, blinking, bold, shadow

Color : 128 colors + blinking 16 colors 

*The following fonts are also available.

 For the details of Gothic, Central Europe, Cyrillic, Greek, and Turkish, refer to "Reference Manual 

 (Operation)" and "V-SFT Additional Specifications."

1. Specifications

Display Function Specifications

Drawing Environment
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                    Item

Screens

Screen Memory

Switches

Actions of Switch

Lamps

Graphs

                                              Specifications

Max. 1024

FP-ROM (flash ROM), Appox. 2,760kbytes  (different from the language)

768 per screen

Set, reset, momentary, alternate, to light
(possible to press a function switch and a display switch at the same time)

Reverse, blinking, exchange of graphics
768 per screen

Pie, bar, panel meter and closed area graph can be displayed without limit.
Total capacity per screen: within 128kB
Statics and trend graphs: Max. 256 per layer

No limits, total capacity per screen: within 128 kB

No limits, total capacity per screen: within 128 kB

Resolution : 640X480, Max. 80 characters

No limits, total capacity per screen: within 128 kB

6144 lines

Sampling display of buffer data

(constant sample, bit synchronize, bit sample, relay sample, alarm function)

Max. 1024

Max. 1024

Max. 2560

Max. 1024

Max. 1024

Max. 1024

Max. 1024

Max. 1024

provided

provided, 2 types (intermittent short and long sounds)

ON at all time, specified freely

Self-test function of switches

Check function of communication parameter setting

Check function of communication

D
at

a 
S

et
tin

g

*1  Layer : 4 per screen (base + 3 overlaps) 

*1

Messages

Sampling

Multi-Overlaps

Data Blocks

Graphic Libraries

Patterns

Macro Blocks

Page Blocks

Direct Blocks

Screen Blocks

Calendar

Buzzer

Back-light Auto OFF Function

Self-diagnostic Function

Numerical Data Display

Character Display

Message Display

1. Specifications

Function Performance Specifications
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Terminal Block (TB1)7
1. Signal Assignment (TB1)

Pin arrangement is shown below:

Signal Name

KEY2 COM

TXD

RXD

SG

+24V

0V

+SD

-SD

+RTS

-RTS

Contents

Key switch 2

RS-232C send data

RS-232C receive data

Signal groundRS-485 send data (+)

RS-485 send data (-)

RS-485 control signal

RS-485 control signal

RTS

CTS

RS-232C control signal

RS-232C control signal

Power supply

Ground

+CTS

-CTS

RS-485 control signal

RS-485 control signal

+RD

-RD

RS-485 receive data (+)

RS-485 receive data (-)

D01

D03

COM-

EMG1

EMG2

External output switch 1

External output switch 3

External output switch common

Emergency stop 1

Emergency stop 2

D02

D04

External output switch 2

External output switch 4

E_ COM

FG Frame ground

KEY1 Key switch 1

Emergency stop 1, 2 common

Signal Name Contents

TB1 MJ1

S
W

1

CURRENT : 0.4A
INPUT : 24VDC

TYPE : V608CH
LOT No. :

MADE IN JAPAN
Hakko Electronics Co., Ltd. 

TxD RxD +SD -SD +RTS -RTS D01 D03 COM- EMG1EMG2 +24V 0V

RTS CTS SG +RD -RD +CTS -CTS D02 D04 E_COM KEY1 KEY2
COM

FG

TB1

1. Terminal Block (TB1)
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V6 PLC

Communication/ Power supply cable

Grounding with resistance 100    or less

2. Power Supply Terminal

Connect the power supply cable to the shaded positions.

Power Cable Connection

• A power supply source within the allowable voltage fluctuation should be used.

• Use a power supply source with low noise between cables, and between cables and the ground.

• To reduce a possible voltage drop, use a thicker cable.

• Keep the 24-VDC line sufficiently away from high-voltage, large-current cables.

Grounding

Make sure that MONITOUCH is well grounded.

(grounding resistance less than 100 ohm or less)

To supply the power from PLC

• Connect FG on the side of the unit to the PLC earth, and ground the

PLC earth.

To supply the power from the external unit

• Connect FG on the side of the unit to the PLC earth, and ground

the PLC earth if the input power supply between PLC and the

external equipment is the same.

• Ground individually if the input power supply between

them is different.

• If the grounding conductor is shared or if the grounding cable is connected to a beam of the building, a

harmful influence may be exerted.  Be sure to avoid such connection.

• If grounding causes a malfunction, separate the FG terminal from the grounding conductor.

TxD RxD +SD -SD +RTS -RTS D01 D03 COM- EMG1 EMG2 +24V 0V

RTS CTS SG +RD -RD +CTS -CTS D02 D04 E_COM KEY1 KEY2
COM

FG

TB1

1. Terminal Block (TB1)

External 
Power Supply PLC

Power supply
 cable

Grounding with resistance 100     or less

V6

PLC

Power supply
 cable

Grounding with resistance 100    or less

V6External 
Power Supply

Communication
 cable

Grounding with resistance 100    or less
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3. Emergency Stop Switch

The emergency stop switch signal is output.  Connect the cable to the shaded positions.

Emergency Stop Switch Specifications

TxD RxD +SD -SD +RTS -RTS D01 D03 COM- EMG1EMG2 +24V 0V

RTS CTS SG +RD -RD +CTS -CTS D02 D04 E_COM KEY1 KEY2
COM

FG

TB1

Number of Switches

Type

Average Mechanical Life

Rating

1

Push-lock type (2 "b" contacts, common)

100 thousand actuations or more

Rated using voltage 24V Resistance load 1.0A

Item Specifications

1. Terminal Block (TB1)



1 - 17

4. External Output Switches

The external output switch signal is output to the external equipment.  Connect the cable to the shaded

positions.

External Output Switch Specifications

Number of Output

Output Form

Rated Voltage

Max. Drive Current

Insulation

Circuit Diagram

Points 4

Synchronous output

12 to 24 VDC

50 mA

Photo coupler insulation

Item Specifications
Internal circuit

DO4

DO1

COM

22

DC12-24V

Load

Load

+
-

TxD RxD +SD -SD +RTS -RTS D01 D03 COM- EMG1EMG2 +24V 0V

RTS CTS SG +RD -RD +CTS -CTS D02 D04 E_COM KEY1 KEY2
COM

FG

TB1

Do not use the external output switch for emergency.

1. Terminal Block (TB1)
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6. Serial Interface

PLC communication can be performed through the serial interface.  Connect the cable to the shaded

positions.

Interface Specifications

Signal Level

Baud Rate

Parity

Data Length

Stop Bit

Connection

RS-232C or RS-422/485

4800, 9600, 19200, 38400, 57600, 76800, 115200

Even, odd, none

7, 8 bits

1, 2 bits

Terminal block connection

Item Specifications

TxD RxD +SD -SD +RTS -RTS D01 D03 COM- EMG1EMG2 +24V 0V

RTS CTS SG +RD -RD +CTS -CTS D02 D04 E_COM KEY1 KEY2
COM

FG

TB1

5. Key Switch (Optional)

The key switch signal is output.  Connect the cable to the shaded positions.

Key Switch Specifications

TxD RxD +SD -SD +RTS -RTS D01 D03 COM- EMG1 EMG2 +24V 0V

RTS CTS SG +RD -RD +CTS -CTS D02 D04 E_COM KEY1 KEY2
COM

FG

TB1

Number of Switches

Number of Contacts

Average Mechanical Life

Average Electrical Life

Rating

1

1 "a" contact

250 thousand actuations or more

100 thousand actuations or more (open/close frequency: 1200 times/h)

Rated using voltage 24V Resistance load 1.0A

Item Specifications

1. Terminal Block (TB1)
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7. Connection

Three kinds of V6 to PLC connection styles are available as shown below.

1:1 Connection

Connect one V6 to one PLC (1:1).

Refer to [8. 1:1 connection] page 1-21.

V6 PLC

Via RS-232C or RS-422 (RS-485) interface

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

1:n Link Communication (Multi-drop)

Refer to [9. 1:n Link Communication] page 1-23.

V6

run

stop

PLC1

run

stop

PLC2

run

stop

PLC3

run

stop

PLCn

RS-422/485      Maximum length 500m
(from V6 to the last PLC)

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

PLC

 V6 : 1 V6 : 2 V6 : 3 V6 : n

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

RS-485       Maximum length 500m
(from PLC to the last V6)

1. Terminal Block (TB1)

n : 1 Link Communication (Multi-Link)

Refer to [10. n:1 Link Communication] page 1-25.
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8. Cables

• Use cables of OD ø8.5 to 10.5 mm.

If a cable less than ø8.5 mm in diameter is used, IP65 cannot be retained.

• Recommended cables

Use Hakko Electronics’s cable “V6H-C  (  : 3.5, 15, 20 m).”

• Tighten terminal screws within the following torque range when connecting the cable.

Do not tin core wires.

• Recommended bar terminals

• Recommended connectors

<Example>

Screw Size

M2

Tightening Torque

0.22-0.25N  m

Single Cable

0.14-1.5mm2

Twisted Cable

0.14-1.0mm2

Manufacturer

Phoenix Contact

Type

AI0.25-6YE
AI0.34-6TQ
AI0.5-8WH

Manufacturer Type

NJW-2831-PM

NJW-2831-RF

Name

Adaptor

Receptacle
Nanaboshi Electric

Note on Communication Cable Connection
• Do not connect the communication

cable together with the electric circuit.

• Do not tie the communication cable

with electric cables in the duct as

shown at right.  Doing so may cause

a noise problem.

• Connect the communication cable

independently from other cables.

Communication cable

Power/control cables

Insulating cable tie

Cable duct

Power/control cables

Communication cable

MADE IN JAPAN
Hakko Electronics Co., Ltd. 

Adaptor

Receptacle

1. Terminal Block (TB1)
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Connect one V6 to one PLC (1:1).

1:1 Connection8
V6 PLC

Via RS-232C or RS-422 (RS-485) interface

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

1. 1:1 Connection

RS-422 (RS-485) Communication

For more information on connection with PLCs, refer to “V6 Hardware Specifica-

tions.”

Match signal names between V608CH (TB1) and V6 (CN1) (shown in connection

diagrams included in “V6 Hardware Specifications”) for connection.  Ignore pin

numbers of V6 (CN1).

<Example>

When connecting V6 with MITSUBISHI’s calculator link unit A1SJ71UC24-R4:

Refer to connection diagram 3 (page 2-1) in “V6 Hardware Specifications.”

Shielded

Signal name

+RD

-RD

+SD

-SD

To the RS-422 port 
of the PLC link unit

SG

V6 (TB1) FG

Send data (-)

Send data (+)

Receive data (-)

Receive data (+)

SG

V6  (CN1)

PLC

D-sub  25pin(Male:    )

FG

SG

+SD

-SD

+RD

-RD

1

7

12

13

24

25

SDA

SDB

SG

RDB

RDA

Signal names 
of V6 (TB1)

Ignore pin numbers

.* Use a twist-shielded cable.

• In the case of RS-422 interface, +SD/-SD and +RD/-RD are paired.

• If SG is present, connect the wire.

• Connect the shielded cable to PLC.

• Set the terminating resistance with the Slide switch.  (Refer to “12. Slide Switch.”)
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Signal name

SD

RD

RS

CS

Shielded

To the RS-232C port 
of the PLC link unit

SG

Receive data

SG

SG

Send data

V6 (TB1)

V6  (CN1)

PLC
D-sub  25pin(Male:    )

D-sub 9pin(Male:    )FG

SD

RD

RS

CS

SG

1

2

3

4

5

7

RD

SD

RS

CS

DR

SG

CD 1

2

3

5

6

7

8* Use a twist-shielded cable.

TxD

RxD

RTS

CTS

SG

V608CH 
 (TB1)

Signal names on the terminal block

Connection diagram included in "V6 Hardware Specifications"

RS-232C Communication

For more information on connection with PLCs, refer to “V6 Hardware Specifica-

tions.”

Match signal names between V608CH (TB1) and V6 (CN1) (shown in connection

diagrams included in “V6 Hardware Specifications”) for connection.  Ignore pin

numbers of V6 (CN1).

<Example>

When connecting V6 with MITSUBISHI’s calculator link unit A1SJ71UC24-R2:

Refer to connection diagram 1 (page 2-1) in “V6 Hardware Specifications.”

• Connect the shielded cable to either V6 or PLC.

• When the communication between V6 and PLC is not performed properly due to noise, SD/SG and

RD/SG are paired.

Signal name

SD

RD

RS

CS

Shielded
To the RS-232C port 
of the PLC link unit

SG

Receive data

Send data

V6 (TB1)

SG
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V6

run

stop

PLC1

run

stop

PLC2

run

stop

PLC3

run

stop

PLCn

RS-422/485      Maximum length 500m
(from V6 to the last PLC)

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

1:n Link Communication

(Multi-drop)9

MITSUBISHI ELECTRIC

OMRON

SHARP

Hitachi

Matsushita Electric Works

Yokogawa Electric

Yaskawa Electric

Toyoda Machine Works

Fuji Electric

KOYO ELECTRONICS

Allen-Bradley

GE Fanuc

TOSHIBA

Siemens

SHINKO ELECTRIC

SAMSUNG

KEYENCE

LG

FATEK AUTOMATION

IDEC

MODICON

TAIAN

                                     Models

A series link, QnA series link, QnH(Q) series link, A link+Net10, 

FX series link(A prt)

SYSMAC C, SYSMAC CV, SYSMAC CS1/CJ1, SYSMAC CS1/CJ1 DNA

JW series, JW100/70H COM port, JW20 COM port

HIDIC-H

MEWNET

FA500, FA-M3, FA-M3R

MEMOBUS, CP9200SH/MP900

TOYOPUC

MICREX-F series, FLEX-PC series, FLEX-PC COM(T)

SU/SG, SR-T

PLC-5, SLC500, Micro Logix 1000

90 series

T series

S7-200 PPI, S7-300/400MPI*

SELMART

SPC series, N_plus, SECNET

KZ series link, KZ/KV series CPU 

MASTER-K500/1000, MASTER-KxxxS CNET, GLOFA CNET

FACON FB series

MICRO3, MICRO Smart

Modbus RTU

TP02

Universal Serial

Manufacturer

* Up to 4 PLCs can be connected to one V6.

One V6 and multiple PLCs are connected.  (n = 1 to 32)

Available PLC for multi-drop communication

1. 1 : n Link Communication (Multi-drop)
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Signal

FG

RDA

RDB

SDA

SDB

SG

Link unit

Signal

FG

RDA

RDB

SDA

SDB

SG

Link unit

RD terminal resistance
(ON)

Signal

FG

+SD

-SD

+RD

-RD

SG

V6 (TB1)

* Use a twist-shielded cable.

Signal

FG

RDA

RDB

SDA

SDB

SG

Link unit

Terminal resistance
(OFF)

Terminal resistance
(OFF)

Terminal resistance
(ON)

Multi-drop Communication (RS-422)

Refer to the PLC manual of each manufacturer for connection.

<E.g.>

The following example describes how one V6 is connected to three PLCs made by MITSUBISHI.

See MITSUBISHI’s manual for further details.

1. 1 : n Link Communication (Multi-drop)



1 - 25

n : 1 Link Communication10

PLC

V6 master
(Local Port 1)

V6 slave
(Local Port 2)

V6 slave
(Local Port 3)

V6 slave
(Local Port 4)

CN1CN1CN1CN1 MJ2
term

inal

Communication between the stations : RS-485 (2-wire system)  Maximum length: 500 m

(a) (b) (c) (d) (e)

Multi-link2

Up to 4 units can be connected to one PLC.

* Between a PLC and the V6 master station is the same as those for 1:1 communication.

V608CH works as only slave station.

• For the I/F driver, the Multi-Link 2 is supported by the version of 1.100 or later

• To use V608CH for slave station,  the hardware version of the V6 master station makes sure as follows.

The hardware version record [LOT No] of V6 is on the rear side.

* The Multi-Link 2 cannot be used with a communication interface unit such as CU-00, 01, 02, 03, 04, 05.

* The Multi-Link 2 cannot be used with Temperature control network.

V612T

V612C

V610S

V610T

V610C

V608C

Analog type

D or later

C or later

D or later

D or later

C or later

F or later

Hardware Version

Matrix type
master station 

All Hardware version MADE IN JAPAN

Hard Version
TYPE :V610T
LOT No :9040054
INPUT :100-240VAC
CURRENT :0.6-0.4A

E

1. n : 1 Link Communication
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         Manufacturer                                Models

MITSUBISHI ELECTRIC        A series link, A series CPU, QnA series link, QnA series CPU, 

                                               QnH(Q) series link, QnH(A) series CPU, QnH(Q) series CPU,

                                               Q00J/00/01 CPU,  FX series CPU, FX2N series CPU, 

                                               FX1S series CPU, FX series link(A prt) 

OMRON                  SYSMAC C, SYSMAC CV, SYSMAC CS1/CJ1

SHARP                  JW series, JW100/70H COM port, JW20 COM port

Hitachi                  HIDIC-H, HIDIC-S10/2alpha, HIDIC-S10/ABS

Matsushita Electric Works      MEWNET

Yokogawa Electric                  FA500, FA-M3, FA-M3R

Yaskawa Electric                    MEMOBUS, CP9200SH/MP900

Toyoda Machine Works          TOYOPUC

Fuji Electric                             MICREX-F series, MICREX-F series V4, FLEX-PC series, 

                                               FLEX-PC CPU, FLEX-PC COM(T), FLEX-PC series(T), 

                                               FLEX-PC CPU(T)

KOYO ELECTRONICS          SU/SG, SR-T, SR-T(K prt), SU/SG(K-Sequence)

Allen-Bradley                  PLC-5, SLC500, Micro Logix 1000, Control Logix

GE Fanuc                  90 series, 90 series(SNP-X)

TOSHIBA                  T series, EX series

TOSHIBA MACHINE              TC200

Siemens                  S5, S5 PG port, S5 V4, S7, S7-300MPI(HMI ADP), 

                 S7-300MPI(PC ADP), S7-300MPI(Helmholz SSW7 ADP), 

                 TI500/505, TI500/505 V4

SAMSUNG                  SPC series, N_plus, SECNET

KEYENCE                              KZ series link, KZ-A500 CPU, KZ/KV series CPU, KZ24/300 CPU, 

                                               KV10/24 CPU, KV-700 CPU

LG                  MASTER-K10/60/200, MASTER-K500/1000, MASTER-KxxxS, 

                                               MASTER-KxxxS CNET, GLOFA CNET, GLOFA GM series CPU

FANUC                                   Power Mate

FATEK AUTOMATION           FACON FB series

IDEC                  MICRO3, MICRO Smart

MODICON                  Modbus RTU

Yamatake                               MX series, DMC50

TAIAN                  TP02

(b) (c) (d) (e)

Signal

FG

+SD

-SD

+RD

-RD

SGSG

V6 slave
TB1

V6 slave
TB1

V6 slave
TB1

Terminal block
prepared by user

V6 master
MJ1/2

Terminal resistor
(OFF)

Terminal resistor
(OFF)

Signal

+

-

Signal

FG

+SD

-SD

+RD

-RD

SG

Terminal resistor
(ON)

Terminal resistor
(ON)

Signal

FG

+SD

-SD

+RD

-RD

SG

12
34

56
78

1. n : 1 Link Communication

Available PLCs for multi-link2.

As of December 2003, the PLCs supported are as follows.  All the PLCs which are usable for 1:1

communication will be supported.

Example of a connection between V6 units.

See Multi-link2 manual for further details.

* In order to avoid noise, wire the shielded FG only at the one of both sides so that they are not

   connected.
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Multi-link

Multiple V6 and a PLC are connected. (n=1 to 32)

 Manufacturer

MITSUBISHI ELECTRIC

SHARP

Hitachi

Matsushita Electric Works 

Yokogawa Electric

Toyoda Machine Works

Fuji Electric

TOSHIBA

Siemens

SHINKO ELECTRIC

SAMSUNG

LG

                                  Models

A series link, Alink+Net10, FX series link(A prt) 

QnA series CPU (with V-MDD)

JW series, JW100/70H COM port, JW20 COM port

HIDIC-H

MEWNET

FA500, FA-M3, FA-M3R

TOYOPUC

MICREX-F series, FLEX-PC COM(T)

T series

S7-200 PPI, S7-300/400MPI*

SELMART

SPC series, N_plus, SECNET

MASTER-K500/1000

* Up to 3 units can be connected to one PLC.

PLC

 V6 : 1 V6 : 2 V6 : 3 V6 : n

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

RS-485       Maximum length 500m
(from PLC to the last V6)

Available PLCs for multi-link

1. n : 1 Link Communication

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

* The connections shown below are not recommended.
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+RxD

+TxD

+DSR

+DTR

1

2

3

4

5

SG7

-RxD15

-TxD16

-DSR17

-DTR18

20

21

Signal

FG

+SD

-SD

+RD

-RD

SG

V6
TB1

RD terminal resistance
(ON)

RD terminal resistance
(OFF)

RD terminal resistance
(OFF)

Signal

FG

+SD

-SD

+RD

-RD

SG

V6
TB1

V6
TB1

Signal

V-MDD
GD port

FG

+SD

-SD

+RD

-RD

SG

* Use a twist-shielded cable.

SignalPin No.

Signal

FG

+SD

-SD

+RD

-RD

SG

V6
TB1

RD terminal resistance
(ON)

RD terminal resistance
(OFF)

Signal

FG

+RxD

-RxD

+TxD

-TxD

SG

Link unit

Signal

FG

+SD

-SD

+RD

-RD

SG

RD terminal resistance
(OFF)

Signal

FG

+SD

-SD

+RD

-RD

SG

* Use a twist-shielded cable.

V6
TB1

V6
TB1

Terminal resistance
(ON)

When multiple V6 are connected to a link unit of PLC

Connect multiple V6 to a PLC by 2-wire connection.

When multiple V6 are connected directly to MITSUBISHI’s QnA series

CPU

 The optional equipment, V-MDD is required.

1. n : 1 Link Communication
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Modular Jack (MJ1)11
Modular Jack (MJ1)

Pin numbers and signal names of modular jack 1 are shown below:

Pin No.
1
2
3
4
5
6
7
8

Signal Name
-
-

+5V
+5V
0V
0V
RD
SD

MJ1

12345678

Function
NC
NC

Power supply for 
peripheral equipment

(Max150mA)

GND
GND

RS-232C receive data
RS-232C send data

Setting of Modular Jack (MJ1)
• Set the use of modular jack 1 on V-SFT Editor.

• Go to [System Setting] from the menu bar, and click [Modular].  Select the following options for

[Modular Jack 1].

Modular Jack 1

[Editor port]

[Barcode]

[V-Link]*

[Modbus Slave]

* For more information about “V-Link,” refer to “V-Link Manual.”

When using the modular jack, remove the I/F cover.  Wall-

mount hardware cannot be used.

Screen Data Transfer
• When transferring screen data, use modular jack 1 (MJ1).

• When [Editor port] is selected for [Modular Jack 1] on the V-SFT, it is possible to select the run/local

main mode automatically.  Screen data can be transferred in the run mode as well.

Also, on-line editing or simulation is possible.

• When an option other than [Editor port] is selected for [Modular Jack 1], select the local main mode for

screen data transfer.  On-line editing or simulation is not possible.

• When transferring screen data, use the cable for screen data transfer (V6-CP, 3 m) for connection

between the personal computer and V6.

1. Modular Jack (MJ1)
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Slide Switch

Setting of Slide Switch (SW1)
Setting of terminating resistance

• When V6 is connected with the PLC via RS-422/485 interface, set SW1 in the ON position.

12

TB1 MJ1

S
W

1

CURRENT : 0.4A
INPUT : 24VDC

TYPE : V608CH
LOT No. :

MADE IN JAPAN
Hakko Electronics Co., Ltd. 

ON

1
OFF

1. Slide Switch
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Installation of Neck Strap and

Cable Clamp13
The neck strap, a V608CH accessory, is used to prevent the unit from dropping; another accessory, a cable

clamp is used to secure the communication cable.

Secure the neck strap and the cable clamp with screws (M3 x 10) at the machine as shown below.

CURRENT : 0.4A
INPUT : 24VDC

TYPE : V608CH
LOT No. :

MADE IN JAPAN
Hakko Electronics Co., Ltd. 

Cable

Cable clamp

Screw

Neck strap

3M 0.3 - 0.5 (3 - 5)

N  m(kgf  cm) Tightening TorqueScrew Size

1. Installation of Neck Strap and Cable Clamp
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Barcode Reader Interface14
• It is possible to receive the signal from a barcode reader by removing I/F cover from V6 and connecting

a barcode reader to V6 via the modular jack (MJ1) of V6 series.

• To connect a barcode reader to V6 via MJ1, use the cable which is the optional equipment made by

Hakko Electronics Co., Ltd. (V6-BCD).

Length : 3m

Accessory : Modular Plug

Notes on Connection

• In case of using the barcode reader which uses the CTS and RTS control, the barcode reader

may not work normally without jumping RTS and CTS.

• The output power supply (+5V) is max. 150mA.  (Refer to page1-29.)

• When the barcode reader connected to V4 is used, connect it to V6 by the following cable.

Pin No.
1
2
3
4
5
6
7
8
9

Signal
CTS
RXD
TXD
RTS

SG

+5V

Red : 0V

Orange : RXD

Yellow : TXD

Brown : +5V

12
34

56
78

* Jump pins, 1(CTS) and 4(RTS).

D-sub 9pin (   )

Signal
RTS
TXD
RXD
CTS
SG
+5V

Barcode Reader

*

Red : 0V

Orange : RXD

Yellow : TXD

Brown : +5V

12
34

56
78

1. Barcode Reader Interface
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Operation of V6 Main Menu1

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

"Main Menu" after the transfering dataWhen power is turned on for the first time:

1998-5 -5  09:00:00

SYSTEM PROG. VER. 1.390

FONT

VER.1.210/1.100/1.000

   JAPANESE 32

I/F DRV VER.1.000

MELSEC AnA/N/U

PLC Type : MITSUBISHI AnA/N/U
Comment : Demo

       Error : Stop
Time-Out : 0.50 sec
       Retry : 3

Editor:MJ1

Connection : 1: 1
Sgnal Level : RS232C
PLC Stat. No. :

Baud Rate : 9600
Data : 7
Stop : 1
Parity : Even
Send Delay :  0msec

CF Card

Main Menu

System Information

Screen Data
 Information

Size

Calender

I/O Test

When the power of V6 is turned on for the first time, the screen on the below left is displayed.

"Main Menu"

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

F2

F1

SYSTEM

ENB

F2

F1

SYSTEM

ENB

OFF ON

S
Y
S
T
E
M

M
O
D
E

S
Y
S
T
E
M

M
O
D
E

1998-5 -5  09:00:00

SYSTEM PROG. VER. 1.390

FONT

VER.1.210/1.100/1.000

   JAPANESE 32

I/F DRV VER.1.000

MELSEC AnA/N/U

PLC Type : MITSUBISHI AnA/N/U
Comment : Demo

       Error : Stop
Time-Out : 0.50 sec
       Retry : 3

Editor:MJ1

Connection : 1: 1
Sgnal Level : RS232C
PLC Stat. No. :

Baud Rate : 9600
Data : 7
Stop : 1
Parity : Even
Send Delay :  0msec

CF Card

Main Menu

System Information

Screen Data
 Information

Size

Calender

I/O Test

To move back to [Main Menu] when the screen data has been already transferred to V6,  press the [SYSTEM]

switch, then press the [F1] switch when the [ENB] lamp is lighting.

If the [ENB] lamp is off, press the [deadman] switch to turn the lamp on.  (see page 3-2.)

2. Operation of V6 Main Menu
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POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

1998-5 -5  09:00:00

SYSTEM PROG. VER. 1.390

FONT

VER.1.210/1.100/1.000

   JAPANESE 32

I/F DRV VER.1.000

MELSEC AnA/N/U

PLC Type : MITSUBISHI AnA/N/U
Comment : Demo

       Error : Stop
Time-Out : 0.50 sec
       Retry : 3

Editor:MJ1

Connection : 1: 1
Sgnal Level : RS232C
PLC Stat. No. :

Baud Rate : 9600
Data : 7
Stop : 1
Parity : Even
Send Delay :  0msec

Communication parameter 
contents

Font data version
System program version

V6 model name

Screen data size

Modular jack setting

PLC model name and
file comment set for 
the screen data file

PLC I/F driver version 
and model name

Brings up the [CF Card Transfer] screen 
(see pages 2-9 to 2-13 for more information).

Brings up the [I/O Test] screen
(see pages 2-3 to 2-8 for more information).

Brings up the [Time Adjustment] screen 
(see page 2-14 for more information).

CF Card

Main Menu

System Information

Screen Data
 Information

Size

Calender

I/O Test

[Main Menu] Screen

V6 system information or screen data information is displayed on the [Main Menu] screen.

When an option other than [Editor Port] is selected for [Modular Jack 1], be sure to select the [Main Menu] for

screen data transfer.

2. Operation of V6 Main Menu
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A. [Main Menu] Switch

Pressing this switch brings back the [Main Menu] screen.

F1

SYSTEM

ENB

SYS

F-1

Main Menu

Switch Check

Press the [Main Menu] switch.

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

[Main Menu] screen

1998-5 -5  09:00:00

SYSTEM PROG. VER. 1.390

FONT

VER.1.210/1.100/1.000

   JAPANESE 32

I/F DRV VER.1.000

MELSEC AnA/N/U

PLC Type : MITSUBISHI AnA/N/U
Comment : Demo

       Error : Stop
Time-Out : 0.50 sec
       Retry : 3

Editor:MJ1

Connection : 1: 1
Sgnal Level : RS232C
PLC Stat. No. :

Baud Rate : 9600
Data : 7
Stop : 1
Parity : Even
Send Delay :  0msec

CF Card

Main Menu

System Information

Screen Data
 Information

Size

Calender

I/O Test

[I/O Test] Switch

When the [I/O Test] switch on the [Main Menu] screen is pressed, the following [I/O Test] screen is displayed.

This screen is used to perform a hardware check of V6.

SW1

SW2

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

Main Menu
SYS

F-1

F-2

F-3

SW1

SW2

Key Switch

Self-Loop Test

CTS

NG OK

RTS TB1 RS232C

MJ1 RS485

Please refer to the manual, "Hardware Specifications".

Communicarion Port

Switch Check

Press the [I/O Test] switch.

Deadman Switch

F-4

F-5

F-6

F-7

SW3

SW4

CF Card I/O Test

I/O Test

Self-Loop Test

D C A

E

B

E

F

2. Operation of V6 Main Menu
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C. Deadman Switch

It is possible to check actuation of the deadman switch.

Hold down the deadman switch and check that the [Deadman Switch] lamp lights on the screen.

If the [3-Position Deadman Switch] is used, and the lamp

is lighting, check that the lamp goes off when the switch is

pressed more strongly.

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

Main Menu
SYS

F-1

F-2

F-3

SW1

SW2

Key Switch

Self-Loop Test

CTS

NG OK

RTS TB1 RS232C

MJ1 RS485

Please refer to the manual, "Hardware Specifications".

Communicarion Port

Switch Check

F-4

F-5

F-6

F-7

SW3

SW4

I/O Test

Self-Loop Test

Deadman Switch

Press the deadman switch.

B. [Switch Check] Switch

It is possible to check the response of touch switches on the V6 screen.

Pressing the [Switch Check] switch brings up the screen that is divided into tiles.

Press on the touch screen and check that the pressed

tiles turn white.

When the tiles turn white, touch switches are responsive

and working properly.

To move back to the [I/O Test] screen, press the [F2]

switch.

To clear the screen, press the [F3] switch.

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

Press the [Switch Check] switch.

X:           Y:

Returm

Erase

F1

SYSTEM

ENB

Main Menu
SYS

F-1Switch Check

[Switch Check] screen

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

X:           Y:

Return

Erase

OFF ON

2. Operation of V6 Main Menu
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E. [System] & Function Switches

Actuation of 12 switches vertically arranged on both sides of the touch screen can be checked.

Hold down each switch and check that the corresponding lamp lights on the screen.

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

Press the [F3] switch.  
Check that the [F-3] lamp lights.

Main Menu
SYS

F-1

F-2

SW1

SW2Self-Loop Test

CTS

NG OK

RTS TB1 RS232C

MJ1 RS485

Please refer to the manual, "Hardware Specifications".

Communicarion Port

Switch Check

F-4

F-5

F-6

F-7

SW3

SW4

I/O Test

Self-Loop Test

Key Switch Deadman Switch

F-3

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

POWER

SW4

SW3

F7

F6

F5

F4 Main Menu
SYS

F-1

F-2

F-3

SW1

SW2Self-Loop Test

CTS

NG OK

RTS TB1 RS232C

MJ1 RS485

Please refer to the manual, "Hardware Specifications".

Communicarion Port

Switch Check

F-4

F-5

F-6

F-7

SW3

SW4

I/O Test

Self-Loop Test

Key Switch Deadman Switch

Self-Loop T

CTS

NG

Please refer 

F-4

F-5

F-6

F-7

SW3

SW4

I/O Test

Self-Loop T

Key Switch

OFF

Unlock the
 key switch.

D. Key Switch (Optional)

It is possible to check actuation of the key switch.

Unlock the key switch and check that the [Key Switch] lamp lights on the screen.

2. Operation of V6 Main Menu
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F. Self-loop Test

This screen is used for checking the signals that are minimally required for V6 to achieve communication.

TB1: RS-232C Signal Test

Turn on the [TB1] switch and the [RS232C] switch in the [Communication Port] field.

Loop-back test

The SD and RD signals are checked.

1. Install a jumper between "TxD" and "RxD" of TB1 on the backside of V608CH.

2. Press the [Self-Loop Test] switch and check that the [OK] lamp lights.

* If the [NG] lamp lights, contact your local distributor.

 CTS/RTS test

The CTS and RTS signals are checked.

1. Install a jumper between "RTS" and "CTS" of TB1 on the backside of V608CH.

2. Press the [RTS] switch and check that both [RTS] and [CTS] lamps light.  Press the [RTS] switch

again and check that both [RTS] and [CTS] lamps go off.

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

TB1 RS232C

MJ1 RS485

Communication Port

2. Operation of V6 Main Menu
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Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

TB1 RS232C

MJ1 RS485

Communication Port

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

TB1: RS-485 Signal Test
Turn on the [TB1] switch and the [RS485] switch in the [Communication Port] field.

Loop-back test

The SD and RD signals are checked.

1. Install jumpers between "+SD" and "+RD," and "-SD" and "-RD" of TB1 on the backside of V608CH.

2. Press the [Self-Loop Test] switch and check that the [OK] lamp lights.

* If the [NG] lamp lights, contact your local distributor.

CTS/RTS test

The CTS and RTS signals are checked.

1. Install a jumper between "+RTS" and "+CTS," and "-RTS" and "-CTS" of TB1 on the backside of

V608CH.

2. Press the [RTS] switch and check that both [RTS] and [CTS] lamps light.  Press the [RTS] switch

again and check that both [RTS] and [CTS] lamps go off.

2. Operation of V6 Main Menu
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MJ1: RS-232C Signal Test

Turn on the [MJ1] switch and the [RS232C] switch in the [Communication Port] field.

Loop-back test

The SD and RD signals are checked.

Execute the test by connecting the data transfer cable (V6-CP) to CN1.

1.  Connect the modular jack side of V6-CP to MJ1.

2. Install jumpers between pin no.2 side of D-sub connector and "RxD" of TB1 on the backside of

V608CH, and between pin no.3 and “TxD” of TB1.

3. Press the [Self-Loop Test] switch and check that the [OK] lamp lights.

* If the [NG] lamp lights, contact your local distributor.

Self-Loop Test

CTS

NG OK

RTS

Self-Loop Test

CTS

NG OK

RTS

MJ1

V6-CP

Pin No.2RxD
TxD Pin No.3

TB1

CN1 RS232C

MJ1 RS485

Communication Port

2. Operation of V6 Main Menu



2 - 9

CF Card

Pressing the [CF Card] switch on the [Main Menu] screen brings up the following [CF Card Transfer] screen.

It is possible to transfer data between CF Card and V608CH on this screen.

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

Main Menu

[CF Card Transfer] screen

Press the [CF Card] switch.
CF Card Transfer

SW1

SW2I/O Test

OFF ON

Display <-- Card

Display --> Card

Display <--> Card

Transfer Menu

CF Card

Folder Name

DSP

CARD

SRAM

MEMO

RECIPE

SAMPLE

HDCOPY

BITMAP

File Name

DSPxxxx.BIN

CARD.BIN

- - - -

MEMxxxx.BIN

RECxxxx.CSV

SMPxxxx.BIN

HDxxxx.BIN

BMPxxxx.BIN

Screen data, system programs

Files for memory card mode

 - - - - - - - - 

Memo pad data  (xxxx : 0 to 7)

"Recipe" data

Sampling data  (xxxx : 0 to 11)

Hard copy image data

Bitmap data

File Type

Folder Name
xxxxxxxx Access folder

"xxxx" shows the access folder name that is set 
with CF Card Setting of V-SFT Editor.

DATxxxx Folders

Root Folders

CF Card AAAAAAAA
BBBBBBBB

CCCCCCCC

DSP
CARD
SRAM
MEMO
RECIPE
SAMPLE
HDCOPY
BITMAP

File Name

 Folder Hierarchical Structure 

The hierarchical structure of folders on the CF card is shown below:

2. Operation of V6 Main Menu
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A. Display <- Card

Data on the CF card can be transferred to V608CH

1. Press the [Display <- Card] switch in the [Transfer Menu] field.

The [CF Card File Information window] is displayed.

2. Select a folder on the CF Card. (Skip this process if it is not required to change a folder. )

Press the [Select Folder] switch.

The Select Folder window is displayed.

Select the desired folder using [ ] or [ ],

and press the [OK] switch.

2. Operation of V6 Main Menu

It is necessary to transfer a screen data to CF card from the

V-SFT Editor in advance.  Use [CF Card Manager] function of

the V-SFT, an application software for editing screen data, in

order to  transfer a screen data to CF Card from the editor.

For about [CF Card Manager], See Chapter  3 “6 CF Card

Manager” in this specification.

Crad Transfer

Select Data

Select Folder

Return

Display <-- Card

Folder Name : AAAAAAAA

         Rest    Size :            xxxxKBCF Card File Information

DSP0000.BIN          2001-1-10   0:40:20

 Sys. Program      :   V608CH

                Version:   1.378

Font Data            :   Japanese32

                 Version:   1.100 / 1.092 / 1.000  

I/F Driver             :   General

                Version:   1.230 

Screen PLC Type:

Screen Comment:  

Data Module        :

Access

Press the [Display <-- Card] switch.

Transfer Menu

Display <-- Card

Display --> Card

Display <--> Card

The folder name which is currently selected is displayed.
The [Access Folder Name] set in the screen data of the unit 
is used on the default status.  (See page3-4.)
If there is no screen data in the unit, [DAT0000] is displayed 
as a folder name.
 

The rest size of CF card is displayed here.

This lamp blinks when the unit is communicating with CF card.

The information in the current selected folder is displayed.
If the screen data does not exsit, the blank appears.

Select a folder.

Select the data contents such as I/F Driver,  
Font Data etc. to transfer to the unit.

Bring back to the former status.

Folder Detail

OK

Select Folder

Rest Size:   xxxxxKB

Folder  
Selection

AAAAAAAA
BBBBBBBB
CCCCCCCC

Folder Name: AAAAAAAA
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Press the [Folder Detail] switch to see details of each folder.

The [Folder Detail] screen is displayed.

Confirm the contents of each folder using [ ] and [ ] switch, and then press the [Folder Selection] switch

to move back to the [Select Folder] screen.

3. Press the [OK] switch to move back to [Card Transfer] screen.

Confirm the contents of [CF Card File Information] , and press the [Select Data] switch.

The [Data Selection] window is displayed.

4.   Select the data that will be transferred to the unit, and press the [Start] switch.

Work normally finished.

OK

5. The [Start] switch changes to [Transferring] and blinks.

When the transfer has been completed successfully, the following window is displayed.  Press the [OK]

switch.

For information about other messages, see page 2-13.

2. Operation of V6 Main Menu

Folder Detail

Rest Size:     xxxxxKB

DSP0000.BIN

Folder Selection

DSP
CARD
SRAM
MEMO
RECIPE
SAMPLE
HDCOPY
BITMAP

Folder Name : AAAAAAAA

Card Transfer

Start

Select Folder

Return

Display <-- Card

Folder Name:  AAAAAAAA

  Rest Size:             xxxxKB
CF Card File Information

DSP0000.BIN         2001-1-10   10:40:20

Sys. Program       :  V608Ch

            VERSION:   1.378

Font Data             :  JAPANESE32

            VERSION:   1.100/1.092/1.000

I/F Driver              :  GENERAL

           VERSION :   1.230

 Screen PLC Type :   

 Screen Comment : 

Data Module         :

Select All

Data Selection

Screen Data

I/F Driver

Font Data

Sys. Program

Data Module

Select [Data Module] in the [Data Selection] field 
When the item of [Use Internal Flash ROM as  
Back-up Area] is checked in the [Environment 
Setting] of the editor.

Data Module
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B. Display -> Card

Data in V608CH can be saved on the CF card.

1. Press the [Display --> Card] switch, and then the [Card Transfer] screen is displayed.

2. Confirm the [CF Card File Information], and press the [Start] switch.

3. The [Start] switch changes to [Transferring] and blinks.

When the transfer has been completed successfully, the following window is displayed.  Press the [OK]

switch.

For information about other messages, see page 2-13.

Work normally finished.

OK

2. Operation of V6 Main Menu

Crad Transfer

Select Data

Return

Display --> Card

Folder Name : AAAAAAAA

         Rest    Size :            xxxxKBCF Card File Information

DSP0000.BIN          2001-1-10   0:40:20

 Sys. Program      :   V608CH

                Version:   1.378

Font Data            :   Japanese32

                 Version:   1.100 / 1.092 / 1.000  

I/F Driver             :   General

                Version:   1.230 

Screen PLC Type:

Screen Comment:  

Data Module        :

Access

Press the [Display --> Card] switch.

Transfer Menu

Display <-- Card

Display --> Card

Display <--> Card

The folder name which is currently selected is displayed.
The [Access Folder Name] set in the screen data of the unit  
is displayed as the default.  (See page3-4.)
If there is no screen data in the unit, [DAT0000] is displayed  
as a folder name.
 The rest size of CF card is displayed here.

This lamp blinks when the unit is communicating with CF card.

The information in the current selected folder is displayed.
If the screen data does not exsit, this field keeps blank. 

Select the data contents such as I/F Driver,  
Font Data etc. to transfer to the unit.

Bring back to the former status.

When the [CF Card File Information] field is displayed on the

screen, data in the unit is overwritten.  Take note that the

pre-data is gone off when the overwrite is executed.

If the [CF Card File Information] field is blank, a new file is

created in the DSP folder located below the [Folder Name]
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Message Display in Data Transferring

If an error occurs during transferring data, the message

display window shown on the right is displayed.  The kinds

and the contents of the messages are as shown below.

O K

Work nomally finished.

In case V608CH, the word [Memory-Card] in the following

table is [CF card].

Work normally finished.

Memory-Card not setting

Memory-Card Capacity over

Writing Error occurred.

Selected data does not exist.

V6 type is different.

Selected data can not be read.

Reading Error occurred.

Data discrepant

Screen data on V6 will be broken.

Undefined Error occurred.

The specified operation has been concluded normally.

A memory card is not inserted.
(Or in case of trying to write data into a memory card
when inserting FROM type memory card)

Cannot write the data into a memory card because 
the data size in V6 is larger than the capacity of 
a memory card.

The error occurred while writing data into a memory 
card.

The data in the reading target does not exist.

The specified type of the data in V6 is different from the 
type of the memory card data.

The data in a memory card cannot be read.

The error occurred during writing data into a flash 
ROM of V6.

There is some discrepancy in data, when comparing data 
between a memory card and V6.

This message appears to inform the user that the data in 
V6 will be broken by transferring the font data (the size
which is larger than the present data) from a memory 
card to V6.  (The [OK] switch continues the transferring.
The [Cancel] switch stops transferring.)

The error occurred due to some cause other than 
the above mentioned.

Message                                                                       Contents

2. Operation of V6 Main Menu

C. Display <-> Card

Data in V608CH can be compared with that on the CF card.

1. Select [Display <-> Card] in the [Transfer Menu] field, and press the [Card Transfer] screen is dis-

played.

2. The [CF Card File Information] is displayed.

Data in this screen can be compared with that in the unit.

3.   Press the [Start] switch.

4.   The [Start] switch changes to [Transferring] and blinks.

5.   When the comparison has been completed, a window is displayed.  Follow the instructions displayed

on the screen.

The screen data in V608CH can be compared with the data in

the folder with the same name as the [Access Folder Name]

set in the editor only.
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Time Adjustment

When the clock built in V608CH is used, the time can be adjusted on the [Time Adjustment] screen.

Pressing the [Calendar] switch on the [Main Menu] screen brings up the following [Time Adjustment] screen.

SW1

SW2

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

Main Menu

Set

Date and Time Adjusument

Date :

Time :

Press the [Calendar] switch.

Calender

Time Adjustment 1998-5 -5  9 :00:00

1998 5 5

0 09 : :

- -

+ -

CF Card

2. Operation of V6 Main Menu

1. Set the current date and time using the [ ], [ ], [+] and [-] switches on the screen.

2. Press the [Set] switch to determine the setting.  The date and time indicated in the top of the screen

changes accordingly.

To use the internal clock of V608CH, check [Use Built-in

Clock] in the [Built-in Clock Setting] dialog of V-SFT Editor

beforehand.  (See page 3-3.)
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Function Switches2
Type

[SYSTEM], [F1], [F2], [F3], [F4], [F5], [F6], [F7]

the [SYSTEM] switch

By pressing this switch, the functions of the switches [F1] ~ [F7] are defined.

The type of the [SYSTEM] switch is alternate.  When this switch is pressed once, the

switch menu is displayed by the side of the function switches [F1] ~ [F5], and each

function switch corresponds to an item on the displayed switch menu.

When the [SYSTEM] switch is pressed again, the switch menu which is displayed on

the screen will disappear, and the switches [F1] ~ [F7] make outputs to PLC as defined

by the user.

Function of [F1] ~ [F5] when the switch menu is displayed

  [F1] : Mode

This switch changes the operation mode.

Main Menu Mode --> RUN Mode

Run Mode --> Main Menu Mode (possible to specify the changing time)

  [F2] : Contrast Adjustment (dark)

This switch adjusts the contrast of LCD.  When the [F2] switch is pressed once, the LCD color be-

comes dark.  If this switch is held down for 1 second, the LCD color changes rapidly into darkness.

  [F3] : Contrast Adjustment (intermediate)

This switch also adjusts the contrast of LCD.  When the [F3] switch is pressed once, the LCD color

becomes intermediate.

  [F4] : Contrast Adjustment (light)

This switch adjusts the contrast of LCD.  When the [F4] switch is pressed once, the LCD color be-

comes light.  If this switch is held down for 1 second, the LCD color changes rapidly into lightness.

  [F5] : Backlight

This switch turns the backlight of V6 on or off.

If you want to use this function, you have to set [Backlight] of the [Unit Setting] dialog in [System

Setting].

The following list shows the backlight function specified in the editing software.

SW1

SW2

F3

F2

F1

SYSTEM

ENB

S
Y
S
T
E
M

M
O
D
E

CT

CT

2. Function Switches

Function Switch (F5)

Ignored.

The following actions are added to the regular functions of these items :

Even if the time does not reach the setting time, the backlight will turn off if the

[F5] switch is pressed (provided that bit 11(Backlight) of Read Area n+1 is OFF

level).  (Refer to the “Reference Manual (Function)”.)

If you select [Manual], the backlight will turn on or off only when this switch is

pressed.  Also, you can specify the item, [Backlight Power ON Time Control].

When you turn the power supply of V6 on ...

[ON] : the backlight is lit.

[OFF] : the backlight is off.

Backlight

ON

Auto 1

Auto 2

Auto 3

Manual

Manual2
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Errors Caused on the V608CH3
Communication Error

The followings are the errors which are often caused on the V6 series.

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

Communication Error

Time-Out
Screen No. :

RETRY

This position of the message changes.
Received data No.:

About any other errors except these errors, refer to “Appendix

3 Error” of “Reference Manual (Function).”

2. Errors Caused on the V608CH

Time-Out

Error code received

Check I/F driver

(applicable to I/F

driver for Simulator)

Although a request is sent for

transmission to the PLC, an

answer is not returned within the

required amount of time.

An error code was sent to the link

unit by the CPU of the PLC.

When sending a communication

request to a personal computer

(simulator), there is no reply from

a personal computer.

1) Check the communication parameter.

2) Check the cable and wiring.

3) Data may be disrupted because of

noise. Fix noise.

Solve the problem by examining the

CPU error code.

If a simulator is not used, transfer the

I/F driver for PLC again.

Contents SolutionMessage
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Check

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

Check

Screen No. Error This portion of the message changes.

Use the item number and sub item number to confirm the location where the error took place. Confirm
error details with the error number and make corrections.

Item number
The item number shows the editing screen or the other place where the error is detected.

26 : CF Attribute Table

About any other errors except these errors, refer to “Appendix

3 Error” of “Reference Manual (Function)”.

Screen No. Error

Data has some error

Error : XX (XX:XXX)

Contents

There is no setting for the

received screen.

There is error on screen

create data.

Solution

The screen specified by the PLC has

not been registered.

Check if a screen number which does

not exist is entered for the memory

address “n+2” of the read area.

For the error details and solutions,

refer to “Reference Manual (Func-

tion).”

Message

Error : XX XX : XXX

Sub item number
Item number

Error number

(Warning)

2. Errors Caused on the V608CH
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SYSTEM ERROR

When a system error is detected, the following error screen is displayed.

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

OFF ON

SYSTEM ERROR : 32

TEA: XXXXXXXX EXPEVT: XXXXXXXX SSR: XXXXXXXX SPC: XXXXXXXX
R0: XXXXXXXX R1: XXXXXXXX R2: XXXXXXXX R3: XXXXXXXX
R4: XXXXXXXX R5: XXXXXXXX R6: XXXXXXXX R4: XXXXXXXX
R8: XXXXXXXX R9: XXXXXXXX R10: XXXXXXXX R5: XXXXXXXX

R12: XXXXXXXX R13: XXXXXXXX R11: XXXXXXXX R12: XXXXXXXX

Others

About any other errors like [Warning] or [Touch switch is active], refer to “Appendix 3 Error” of “Reference

Manual (Function).”

SYSTEM Error : XX

  1 : Watch dock timer error

 11:  Switch table error

30 : Request for displaying full error

31 : Memory allocation system error

32 : General exceptions/MMU address system error

33 : RTOS system error

34 : Memory error

(when detecting an error by self-check of RAM)

35 : Inaccurate memory error

(when detecting an access to a memory of an inaccurate memory model,

e.g. PLC or internal memory etc.)

The source of the error could be one of the following three problems. Contact the technical

support department of your distributor.

1) Program crash due to noise

2) Hardware problem

3) Bad program

2. Errors Caused on the V608CH
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Handy Setting1
To use V608CH, select [V608CH (640*480 7.7 inches)] in the [Edit Model] dialog of [System

Setting].

Also, make settings for the deadman switch and the key lock switch in the [Handy Setting]

dialog.

1. Select  [System Setting] from the menu bar, and click the [Unit

Setting].

The [Unit Setting] dialog is displayed.

3. Handy Setting

2.   Select the [Handy Setting] tab.

The [Handy Setting] dialog comes up.

[  Use Deadman Switch]

Choose whether or not to use the deadman switch for operation.

To allow screen operation at all times, uncheck this box.

[  Use Key-lock Switch]

Check this box to use the key switch.

To allow screen operation at all times regardless of the key switch setting, uncheck this

box.

Use/no use of the deadman

switch can be switched

during the run mode using

the macro command.  (See

the next page.)

The selection in the [Handy

Setting] dialog is validated at

power-up.
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Deadman Switch

To prevent misoperations, V608CH is equipped with a deadman switch.

When the deadman switch is used:
Screen operation is available only when the deadman switch is on (ENB lamp ON).

When the deadman switch is not used:
Screen operation is available whether the deadman switch is on or off.

Regardless of the above, screen operation is available while

the [Main Menu] screen is displayed.

Setting Procedure

Use/no use of the dead man switch can be set in the following two methods.

(a) Select [System Setting] from the menu bar, and click  [Handy Setting] in the [Unit

Setting] on V-SFT Editor (See the previous page.)

(b) Macro command "SET_DSW"

Usable Device

SYS(SET_DSW) F1

F0

Internal Memory PLC Memory Constant Memory Card Indirect Designation

F1

(SET_DSW)

F1 0: Not used  1: Used

3. Handy Setting

The selection in the [Handy Setting] dialog is validated at

power-up (default setting).

To change the selection during the run mode, use the macro

command.  The setting made with the macro command is

reset to the default when the power is turned off.
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Built-in Clock Setting2
The current time and date can be displayed on V608CH in the following two methods:

To use the clock built in V608CH

To use the PLC's calendar data

When using the clock built in V608CH, set the [Built-in Clock Setting] dialog of V-SFT Editor.

Setting Item

Check the [Use Built-in Clock] box.

System Setting Built-in Clock Setting

To retain calendar data when the power is off, use a backup

battery "V6H-RB," that is available as an optional accessory.

Calendar data can be adjusted on the [Main Menu] screen of

V608CH.  Refer to "Time Adjustment" (page 2-14).
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3 CF Card Setting

3. CF Card Setting

The following three items, Access Folder Name, Use Cache and Range of Patterns to be

saved to CF Card can be set in the [CF Card Setting] dialog.

1.   Select the [System Setting] from the menu bar, and click the

[CF Card Setting].

2.   The [CF Card] dialog is displayed.

[Access Folder Name]

This is used as a folder name when data is saved on the Compact Flash card (CF

card).

All the sampling data and hard copy data are stored in this folder.

Set this name within 8 characters (0 to 9, A to Z: a capital letter).

[  Use Cache]

Check the [Use Cache] box in order to use cache.

If the [Use Cache] is checked, cache memory is allocated for each buffering area No.

Also, size of cache can be set.

[  Range of patterns to be saved to CF card]

Check the [Range of patterns to be saved to CF card] box in order to save them on the

card.

If the [Range of patterns to be saved to CF card] is checked, the setting of range of

patterns can be selected.

For more information about cache, see page 3-11.
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CF Card Function

Saving memo pad data for backup (see page 3-7)

Even if the power supply of V608CH is turned off, data can be saved.

The data on the CF card can be converted into a bitmap file using the V-SFT Editor (CF

Card manager).

* It is not possible to read memo pad data created on other V6 models.

Saving hard copy image as a file (see page 3-7)

Hard copy image can be saved as a file using the macro command.  It can be converted

into a bitmap file on V-SFT Editor for use.

Saving patterns (bitmap files) on the CF card (see page 3-8)

Patterns are saved in an area (bitmap folder on the CF card) other than screen data in

order to reduce the capacity of screen data used for them.

Patterns on the CF card can be displayed on the screen to save memory.

Saving sampling data (see page 3-9 to 3-14)

Lots of sampling data can be saved.

Sampling data can be converted into a CSV file using the macro command so that editing

on a spreadsheet is possible.

It is also possible to save data in the same format as that for memory cards or to convert

it into an MCD file that can be read from or written to the memory card editor (optional, M-

CARD SFT).

Saving and reading "recipe" data (see page 3-15 to 3-23)

CSV files can be read using the macro command.  This is useful for changing parameter

settings, etc.  Also, data in the V6 internal memory can be saved as a CSV file.

Transferring screen data and system programs

• Screen data can be transferred between the CF card and V608CH (refer to Chapter 2).

• Multiple screen data can be saved to enable data modification for each system.

• System programs can be transferred for updating the V608CH software version.

Transferring data between the CF card and the computer using CF Card Manager of V-

SFT Editor (see page 3-29 to 3-36)

CF Card Function4
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Notes on Use of CF Cards

Note the following points when using CF cards:

1. Save a backup copy at regular intervals.

2. If a disk error arises and data read/write operation is defeated, perform scandisk opera-

tion on Windows98/Me/2000/XP and restore the disk.  If the disk cannot be restored,

format the disk.

(Windows is a registered trademark of Microsoft Corporation.  For Scan Disk and the

operation of Windows, refer to manuals for Windows.)

3. Do not allow file size to exceed the capacity of a CF card.

4. When accessing the CF card;

• turning the power off or resetting

• removing or inserting the CF card

may destroy data on the CF card.

Before removing or inserting the CF card during the run mode, check that data is not

being transferred.

The CF card can be removed or inserted while the [Main Menu] screen is displayed.

5. The CF card has an average life of approx. 300 thousand write operations.  Conse-

quently, repeating write operations at very close intervals may shorten the card's useful

life.  When saving sampling data, be careful about the sampling time.  (See page 3-11.)

Also, avoid frequent write operations using the cycle macro command.

3. CF Card Function
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1. Memo Pad Data Backup

Memo pad data can be saved.

Location : \MEMO folder

Type : BIN file

File name : MEMxxxx.BIN (xxxx: 0 to 7; memo pad number)

Setting Item

Memo pad

For the setting procedure of memo pad, refer to Chapter 12

in "Reference Manual (Function)."

Timing of Saving on the CF Card

• When the [Plus Block], [Minus Block] or [Block] switch is pressed

• When the screen is changed or the [Main Menu] screen is displayed from the run mode

2. Hard Copy Image File

The current screen image can be saved on the CF card using the macro command.

Location : \HDCOPY folder

Type : BIN file

File name : HDxxxx.BIN (xxxx: 0 to 1023; screen number)

* If the file name already exists, it is named as HD0000~1.BIN.

Setting Item

 Macro command "HDCOPY"

3. CF Card Function
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3. Showing Patterns on the CF Card

Patterns (bitmap files) saved on the CF card can be displayed on the screen.

Memory for screen data can be saved.

Setting Item

Check the [Range of patterns to be saved to CF card] box.

Specify the range of patterns you would like to save on the CF card.

Saving Patterns on the CF Card

System Setting CF Card Setting

3. CF Card Function

1. Select the [File] on the menu bar, and click the [CF Card Manager] to start writing.

2. Insert the CF card into the CF Card Reader/Writer that is connected to the com

puter.

3. Click the [Write to CF Card] of the [File], and specify the screen data.

When the screen data is saved on the CF card, pattern data is simultaneously

saved in the [BITMAP] folder on the CF card.

4. Remove the CF card from the CF Card Reader/Writer in order to insert it into the

unit.

Patterns saved on the CF card are displayed on the screen.

For more information on CF Card Manager, see page 3-29.
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4. Saving Sampling Data on the CF Card I

Sampling data can be saved on the CF card in the same format as it is saved in on the SRAM

card.

It is also possible to convert sampling data into an MCD file using CF Card Manager of V-SFT

Editor, so that it can be opened or edited on the memory card editor (M-CARD SFT).

Location : \CARD folder

Type : BIN file

File name : CARD.BIN

Setting Item

For more information about these settings except for the CF

card, refer to Chapter 10 "Sampling" and Chapter 25

"Memory Card Mode" in "Reference Manual (Function)."

Buffering Area Setting
Select [SRAM] for [Store Target].

Set the same number as the one set for memory card setting for [Output File].

Memory Card Setting
Set the same number as the one set for [Output File] for buffering area setting.

Select [Buffering File] for [Type].

CF Card Setting
When [Use Cache] is not checked:

Sampling data is saved on the CF card each time sampling is performed.

When [Use Cache] is checked:

Sampling data is stored temporarily in the V6 cache, and when some data is accumu-

lated, it is saved on the CF card.

For more information about cache, see page 3-11.

Macro Command "SMPL_SAVE"
To output sampling data in cache to the CF card at random timing, use the macro

command.

System Setting Others

CF Card Use Cache Checked*1
Not checked

*1 Depending on the timing of saving, the macro command "SMPL_SAVE" may be required.

System Setting Buffering Area Setting

Memory Card SettingSystem Setting

Sampling mode

Store Target

Output File No. n (0 to 15)

SRAM

No. n (0 to 15)

I/F Memory
Type: Buffering File

Format switchMemory card mode

It is recom-

mended to check

[Use Cache] due

to the limited

number of write

operations to the

CF card.

3. CF Card Function



3 - 10

5. Saving Sampling Data on the CF Card II

Sampling data can be saved on the CF card.  It is not necessary to format the CF card for

screen data as was required for the SRAM card.  Simply insert the CF card into V608CH.

Location : \SAMPLE folder

* No data is output to \CARD.BIN; however, some area is occupied.

Type : BIN file

File name : SMP0000.BIN to SMP0011.BIN

 (the number indicates the buffering area number)

Setting Item

For more information about these settings except for the CF

card, refer to Chapter 10 "Sampling" and Chapter 25

"Memory Card Mode" in "Reference Manual (Function)."

Buffering Area Setting
Select [CF Card] for [Store Target].

Set the same number as the one set for memory card setting for [Output File].

Memory Card Setting
Set the same number as the one set for [Output File] for buffering area setting.

Select [Buffering File] for [Type].

CF Card Setting
When [Use Cache] is not checked:

Sampling data is saved on the CF card each time sampling is performed.

When [Use Cache] is checked:

Sampling data is stored temporarily in the V6 cache, and when some data is accumu-

lated, it is saved on the CF card.

For more information about cache, see the next page.

Macro Command "SMPL_SAVE"

To output sampling data in cache to the CF card at random timing, use the macro

command.

System Setting Buffering Area Setting

System Setting Memory Card Setting

No. n (0 to 15)

I/F Memory
Type: Buffering File

System Setting CF Card Setting

Use Cache Checked*1
Not checked

*1 Depending on the timing of saving, macro command "SMPL_SAVE" may be required.

Store Target

Output File No. n (0 to 15)

CF Card

Sampling mode

It is recom-

mended to check

[Use Cache] due

to the limited

number of write

operations to the

CF card.

3. CF Card Function



3 - 11

About Cache:

1. Cache Function

There is a limit on the number of write operations available with the CF card.  The limit

does not show the total number of write operations with the CF card but the number of

write operations every unit called sector (512 bytes).  It is impossible to access files (a

part of file) including the sector if the limit comes.  Consequently, if write operation is

performed frequently during sampling, access may be disabled sooner than is normal.

When [Use Cache] is checked, cache memory is allocated for each buffering area

number.  Sampling data is stored temporarily until the output condition (see 4. below) to

the CF card is satisfied, so that the number of write operations can be reduced.

Cache function can be used when either [Memory Card] or [CF Card] is selected for

[Store Target].

<Note>

Cache memory is volatile; when the power is turned off or when the CF card is

removed, data is lost.  Therefore, before turning the power off or removing the CF

card, execute the macro command "SMPL_SAVE" to save data on the CF card.

2. Cache Size Adjustment

The sample buffer size is determined by the sampling method, [No. of Words] and [No.

of Samples].  (See page 10-17 in "Reference Manual (Operation).")  Also, the time

interval for outputting to the CF card is determined by [Sampling Time] and [No. of

Samples].

Refer to the above information and adjust the cache size to reduce the number of write

operations.

The cache size can be 256 words to 2048 words.

<Reference>

Average CF card life: Approx. 300 thousand write operations

• If data is written every 5 minutes in 24-hour operation: Approx. 3 years

• If data is written every 3 minutes in 24-hour operation: Approx. 1.8 years

3. Cache Action

Cache Size > Sampling Buffer Size

3. CF Card Function

Constant Sample 

1 sample :  8 words (The number of words for sample 6+2)
The number of samples : 30 times
Size of cache : 256 words

Size of sample buffer
8x30=240 words

1

2

240

Size of cache

256 words
Data for 240 words stored temporarily in 
cache is saved to CF card when sampling 
time is satisfied.  
If sampling is performed at the interval of 
10 sec., data is saved to the card every 
300 sec. (5 min.). 
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Cache Size < Sample Buffer size

4. Alarm Sampling

Information on run hours, frequency, and the time when the alarm has occurred is also

saved for alarm sampling.

The data is stored in memory other than cache, and is output to the CF card together

with data in cache when the output condition is satisfied.

5. Output Condition to CF Card

1. The specified cache memory is full.

2. The number of sampling times specified for buffering area setting has been exceeded.

3. Macro command "SMPL_SAVE" is executed.

4. Macro command "SMPL_CSV" is executed.

5. The [Reset] switch for the memory card mode is pressed.

6. The bit for resetting (R) in the sample control memory is set.

7. The [Main Menu] screen is displayed during the run mode.

<Note>

• In the cases of 3 and 7 above, data in all buffering areas (No. 0 to 11) is saved on

the CF card.  For other cases, only data in the applicable buffering area is saved on

the CF card.

• In the cases of 5 and 6 above, data in cache is output and is saved into a new file

in the backup folder (see page 3-13) that is automatically date-stamped.

1

2

256

Cache

The first time  256 words

Cache

The second time 144 words

Constant Sample 

1 sample :  8 words (The number of words for sample 6+2)
The number of samples : 30 times
Size of cache : 256 words

Size of sample buffer
8x50=400 words

Data for 256 words stored temporarily in 
cache is saved to CF card when sampling 
time is satisfied. 
The rest data for 144 words is saved to CF 
card when sampling time is satisfied again.
After that, this operation is performed over 
and over again.  

3. CF Card Function
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Usable Device

SMPL_BAK F0

F0

PLC Memory Internal Memory Constant Memory Card Indirect Designation

6. Sampling Data Backup

It is possible to save a backup copy of sampling data stored in the \SAMPLE folder on the CF

card.  Use the macro command "SMPL_BAK."

Location : \SAMPLE\date folder

<Example>

When a backup copy is saved on 2001/9/1 (September 1, 2001), it is placed

in the \SAMPLE\010901 folder.  If the folder name already exists, it is named

as \SAMPLE\010901~1.

Type : BIN file

File name : SMPxxxx.BIN (xxxx: 0 to 11; buffering area number)

Setting Item

Macro command "SMPL_BAK"
A backup copy of sampling data in buffering area No. "F0" is saved on the CF card.

3. CF Card Function
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7. Saving Sampling Data as a CSV file on the CF Card

A sampling data file (\SAMPLE\SMPxxxx.BIN) in the CF card can be converted into a CSV

file and saved.

Location : \SAMPLE folder

Type : CSV file

File name : SMPxxxx.CSV (xxxx: 0 to 11; buffering area number)

("xxxx": the same as that in the BIN file name before conversion)

Usable Device

SMPL_CSV F0

F0

PLC Memory Internal Memory Constant Memory Card Indirect Designation

3. CF Card Function

Setting Item

When converting a BIN file into a CSV file, it is necessary to

set the attribute table (that contains the display format

information) on V-SFT Editor.

For the setting procedure of attribute tables, see page 3-18.

Macro command "SMPL_CSV"
The BIN file of the specified buffering file number "F0" is converted into a CSV file.

System Setting Attribute Table
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8. Transferring "Recipe" Data

"Recipe" data in the \RECIPE folder on the CF card can be imported in the V6 internal

memory.

It is also possible to transfer data from the V6 internal memory to the CF card.

a. Importing a CSV File

A CSV file in the \RECIPE folder can be transferred to the V6 internal memory.

Setting Item

It is necessary to set the attribute table (that contains the

display format information) on V-SFT Editor.

For the setting procedure of attribute tables, see page 3-18.

Create a CSV file and save it in the \RECIPE folder.

Macro Command "LD_RECIPE"
The CSV file number "F1" is transferred to the memory areas starting with "F0."

For the file number, specify the same number set in the "ITEM No." column of the

attribute table.

Usable Device

LD_RECIPE F0 F1

F0

F1

PLC Memory Internal Memory Constant Memory Card Indirect Designation

System Setting Attribute Table

Create CSV File File Name: RECxxxx.csv
Saves in the RECIPE folder

Execute the macro command "LD_RECIPE $u200 1."

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

$u200
$u201
$u202
$u203
$u204
$u205
$u206
$u207
$u208
$u209

1
2
5
4
5

10
20
30
40
50

3. CF Card Function

<Example>

To import the REC0001.CSV file in the \RECIPE folder on the CF card to internal memory

$u200:

\RECIPE REC0000.CSV

REC0001.CSV

REC0002.CSV
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Usable Device

LD_RECIPESEL F0 F1

F0

PLC Memory Internal Memory Constant Memory Card Indirect Designation

F1

"F1" memory

Address
n

n+1
n+2
n+3
n+4

Contents

 File number *
Start row number
Start column number
Number of rows
Number of columns

For the file number, specify the  
same number as RECxxxx.csv set 
in the column of the attribute table.

*

System Setting Attribute Table

Create CSV File File Name: RECxxxx.csv
Saves in the \RECIPE folder

b. Importing Part of a CSV File

Specified columns or rows of a CSV file in the \RECIPE folder can be transferred to the V6

internal memory.

Setting Item

It is necessary to set the attribute table (that contains the

display format information) on V-SFT Editor.

For the setting procedure of attribute tables, see page 3-18.

Create a CSV file and save it in the \RECIPE folder.

Macro Command "LD_RECIPESEL"
Columns or rows of the CSV file number stored in the "F1" memory are transferred to

the memory areas starting with "F0."

<Example>

To import part of the REC0001.CSV file in the \RECIPE folder on the CF card to internal

memory $u100:

$u0000=1 (File No. 1)

$u0001=2 (Start row No. 2)

$u0002=3 (Start column No. 3)

$u0003=1 (1 row)

$u0004=3 (3 columns)

Execute the macro command

"LD_RECIPESEL $u100 $u0000."

POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

$u100
$u101
$u102

30
40
50

3. CF Card Function

\RECIPE REC0000.CSV

REC0001.CSV

REC0002.CSV

Row No.

Column No.
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c. Creating a CSV File

Data in the V6 internal memory can be saved as a CSV file in the \RECIPE folder.

Setting Item

It is necessary to set the attribute table (that contains the

display format information) on V-SFT Editor.

For the setting procedure of attribute tables, see page 3-18.

Macro Command "SV_RECIPE"
Data of "F1" words from the "F0" memory is saved as a file No. "F2" in the \RECIPE

folder.

Usable Device

SV_RECIPE  F0  F1  F2

F0

F1

F2

PLC Memory Internal Memory Constant Memory Card Indirect Designation

System Setting Attribute Table

<Example>

To save six words from the V6 internal memory $u100 as the REC0002.CSV file in the

\RECIPE folder on the CF card:

Execute the macro command

"SV_RECIPE $u100 6 2."
POWER

SW1

SW4

SW3

SW2

F3

F2

F1

F7

F6

F5

F4

SYSTEM

ENB

$u100
$u101
$u102
$u103
$u104
$u105

11
22
33
44
55
66

3. CF Card Function

\RECIPE    REC0000.CSV

   REC0001.CSV

   REC0002.CSV
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9. Attribute Table

To convert a BIN file into a CSV file, information about the display format and the word length

(single-word or double-word) is required, and should be set on the attribute table of V-SFT

Editor.

To use the following functions, the attribute table should be set:

a. To convert an SMPxxxx.BIN file in the \SAMPLE folder into a CSV file

b. To transfer a RECxxxx.CSV file to the V6/PLC memory, or to save data in the V6

internal memory as a RECxxxx.CSV file

CF Attribute (Attribute Table)

Starting

Select  [System Setting] from the menu bar and click the [Attribute Table].  The [CF

Attribute] window is opened.

Exiting

Click the upper left of the screen and select [Close] from the menu.

Or click the [X] box at the upper right corner.

or

3. CF Card Function
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a. Converting an SMPxxxx.BIN File into a CSV File

Setting Item

CF Attribute (Attribute Table)

System Setting Attribute Table

System Setting Buffering Area Setting

Sampling Mode

3. CF Card Function

Procedure to enter comments

1. Specify the attribute table No. to write down

comments.

2. Right-click to select [Name Change], and

write down comments.

* Up to 16 characters can be used for a

comment.

Correspond to “xxxx” of SMPxxxx.BINCommentsAttribute table No.
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Attribute Setting

1. Select the attribute No. for attribute setting.

2. Click [Attribute Setting] from the [Edit] menu.

Or, right-click and select [Attribute Setting].

3. The [Attribute Setting] dialog is displayed.

Double-clicking

also brings up the

[Attribute Setting]

dialog.

Constant Sample/Bit Synchronize/Temp. Control Net/PLC2

[Time Format] field

Set the display format of data and time.

3. CF Card Function

Or

Right-click
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Bit Sampling
Set the display format of date and time, and items for the sampling mode.

Alarm Function

Set the display mode, the display format of date and time, etc.

3. CF Card Function

[Setting of each data format]

Make setting for each data format.  The items shown in the diagram below can be set.

[Apply same setting]

Applies the format of the currently selected data to all.

Type

DEC
DEC-
HEX
OCT
BIN
CHAR
BCD
FLOAT

Decimal Point (0 to32) Characters (0 to 256)

Characters : the number of bytes

No. of Words

1 Word/ 2 Word

2 Word

1 Word/ 2 Word
1 Word/ 2 Word
1 Word/ 2 Word
1 Word/ 2 Word

1 Word/ 2 Word
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CSV File Examples

Examples of CSV files created using the macro command "SMPL_CSV" are shown below:

Bit Synchronize

Bit Sampling

Alarm Function

3. CF Card Function

CF Attribute No.

CF Attribute No.

Primary cause

CF Attribute No.
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b. Transferring a RECxxxx.CSV File to V6 Internal Memory,

    or Saving V6  Internal Memory Data as a RECxxxx.CSV File

Setting Item

CF Attribute (Attribute Table)

System Setting Attribute Table

RECIPE folder on the CF card Create CSV File

REC0000.CSV

REC9999.CSV

Exporting to a CSV File
The attribute table created in the [CF Attribute] dialog can be saved as a CSV file.

Click [Export to CSV File] from the [File] menu, and give a file name.

Importing from a CSV File
An exported CSV file can be imported to the [CF Attribute] dialog after editing on a

spreadsheet, such as Excel.

Click [Import CSV File] from the  [File] menu, and select the desired CSV file.

3. CF Card Function

Attribute table No. Comments
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Double-clicking

also brings up the

[Attribute Setting]

dialog.

Attribute Setting

1. Select the attribute No. for attribute setting.

2. Click [Attribute Setting] from the [Edit] menu .

Or, right-click and select [Attribute Setting].

3. The [Attribute Setting] dialog is displayed.

3. CF Card Function

Or

Right-click
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[The number of Column]  (1 to 4096)

Set the number of columns in CSV files.

* The maximum number of columns is [4096].  However, depending on the

setting contents of each data, the number is automatically limited if the [Total

Words] reaches to [4096] words.

* The maximum number of columns to handle CSV files on Excel is [256].

[Setting of each data format]

Make setting for each data format.  The items shown in the diagram below can be set.

After making all the settings shown above, the [Total Words] (1 to 4096) is automatically

displayed.

Type

DEC
DEC-
HEX
OCT
BIN
CHAR
BCD
FLOAT

Decimal Point (0 to32) Characters (0 to 256)

Characters : the number of bytes

No. of Words

1 Word/ 2 Word

2 Word

1 Word/ 2 Word
1 Word/ 2 Word
1 Word/ 2 Word
1 Word/ 2 Word

1 Word/ 2 Word

3. CF Card Function
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Procedure to set Attribute Table Newly

1. Click the [Attribute Table] from the [System Setting], and the [CF Attribute] is displayed.

2. Select the [RECIPE] folder, and right-click to display the following menu.

Click the [New Table].

3. The [Attribute Setting No.0] dialog is displayed.

For the setting items in this window, see page 3-25.

3. CF Card Function
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System Memory5
Statuses of the deadman switch, the key switch, external output switches, and the CF card

are output to the system memory ($s).

The contents of $s490 to 499 and $s780 are explained in this section.

For information on other memory areas, refer to "Appendix 1" in "Reference Manual (Func-

tion)."

List of System Memory Contents

Address

  $s490

  $s491

  $s492

  $s493

  $s494

  $s495

  $s496

  $s497

  $s498

  $s499

Contents

V608CH  Switch setting of key switch/deadman switch

V608CH  Answerback of each switch

V608CH  Backup battery (V6H-RB) status

CF card error status

CF card free space (low-order)  Unit: Kbytes

Memory Type

<-V

<-V

Address Details

$s490
Information on whether or not the deadman switch, the key switch and the ENB lamp are

valid is output.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

"0" for all

ENB lamp
0: Invalid
1: Valid

Deadman switch
0: Invalid
1: Valid

Key switch
0: Invalid
1: Valid

3. System Memory

  CF card free space (High-order)  Unit: Kbytes

      $s780          CF card BMP file load information
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15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

"0" for all

Output switches

Deadman switch

Key switch

SW4 SW3 SW2 SW1

4

6

7

12

15

16

No card inserted

Small card size

Invalid card type

Card write error

Disk error (open failure)

Card read error

3. System Memory

$s491
Answerbacks of the output switches, the deadman switch and the key switch are output.

$s492
The status of built-in clock backup battery (V6H-RB) is output.

0: Normal

1: Battery voltage drop (Replace the battery.)

$s497
The result of access to the CF card is output.

$s498 to 499
Free capacity (kbyte) of the CF card is stored.

  $s780
The bitmap file loading information is output.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

"0" for all 0: File exsits. 
1: File not exsit.

0: Compatible with the file format 
1: Incompatible with the file format
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CF Card Manager6
To perform data transfer between V-SFT Editor and the CF card, convert files with the

extensions of [.V6] or [.bmp] into a file format so that the unit can read the data, and then

save it on the CF card.

Also, it is required to convert a file into the file with the extension of [.V6] or [.bmp] in order to

see the data in the card on computer.

CF Card Manager enables to convert these files described above.

A. Starting CF Card Manager (page 3-29)

B. Writing Data into CF Card (page 3-30)

C. Copying CF Card (page 3-33)

D. Back-up of CF Card (page 3-34)

E. Converting a BIN File back to the Original Format (page 3-35)

F. Others (Property) (page 3-36)

A. Starting CF Card Manager

1. Click  [CF Card Manager] from the [File] menu.

2. The following dialog is displayed.

Select the CF card drive and click [OK].

Not only the CF card drive but other drives can be selected in

this window.

3. [CF Card Manager] is started.

3. CF Card Manager
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B. Writing Data into CF Card

  Screen Data (.V6)
Convert the selected screen data into the BIN file format so that the unit can read the

data, and then write it to CF card.

1. Click the [Write to CF Card] from the [File] menu.

2. The [Write to CF Card] is displayed.

[File to be converted]

Click the [Refer], and specify the file to be written to CF

card.

Select the [Screen Data File(*.V6)] as Files of type.

[File comment of BIN file]

This area is used to give a comment to the file (BIN file)

written to CF card.

Click the [OK].

3. A folder set in the [Access Folder Name] is created on the CF card.

The created folder name on the CF card comes

from the [Access folder name] set

in the [CF Card Setting] of the V-SFT Editor.

3. CF Card Manager
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  Memory Card Data (.mcd)
Convert the selected memory card data into the BIN file format so that the unit can

read the data, and then write it to CF card.

1. Click the [Write to CF Card] from the [File] menu.

2. The [Write to CF Card] is displayed.

[File to be converted]

Click the [Refer], and specify the file to be written to CF

card.

Select the [Memory Card File(*.mcd)] as Files of type.

[File comment of BIN file]

This area is used to give a comment to the file (BIN file)

written to CF card.

Click the [OK].

3. The [Specify Save Target] dialog is displayed.

Enter an access folder name to save a mcd file, and click the [OK].

4. A folder is created in the CF card.

3. CF Card Manager
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There are 8 folders shown in the following diagram under an access folder name in CF

card.

[BITMAP]

The item of [Range of patterns to be saved to CF card] can be set on V-SFT in order to

save the size of screen data.  (Relevant to page 3-8)

Pattern data set in this window is saved in CF card.

[CARD]

Both recipe data and sampling data stored in SRAM are saved in a file.

(Relevant to page 3-9)

[DSP]

Screen data, sys. program, I/F driver, and font data are saved in a file.

[HDCOPY]

Data when the [HDCOPY] macro is executed in the unit is saved.  (Relevant to page 3-7)

[MEMO]

Memo pad data in the unit can be saved.

[RECIPE]

CSV files to execute [LD_RECIPE] and [LD_RECIPPESEL] macro are saved in this folder.

(Relevant to page 3-15, 16)

Also, CSV files when [SV_RECIPE] macro is executed are saved.  (Relevant to page 3-17)

[SAMPLE]

Sampling data stored in [CF Card] is saved every buffering area here.

(Relevant to page 3-10 )

[SRAM]

This folder is not available for V608CH.

3. CF Card Manager
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C. Copying CF Card

1. Click [CF Card Copy] from the [File] menu.

2. Select the CF card drive and click [OK].

3. The following dialog is displayed.  Click [OK].

4. Remove the source CF card from the computer and insert the target CF card.  Click

[OK].

5. The following dialog is displayed.  Click [OK] in the dialog.

6. When copying has been completed, the following dialog is displayed.  Copy operation

is complete.

3. CF Card Manager
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D. Back-up of CF Card

Data on the CF card is saved as back-up.

The target place where back-up is saved can be selected freely.

1. Click [Back-up of CF card] from the [File] menu.

2. The [Back-up of CF card] dialog is displayed.

Click the [Refer] in order to specify the place where the data is copied.

<Example>

When data is saved in the My Document of C Drive.

3. Click [OK], and the following dialog is displayed.

4. Click [OK].  The data on the CF card is copied to the target copy.

When copying has been completed, the following dialog is displayed to finish this

operation.

5. Check that data is copied on the Explorer.

The functions of copy and paste are also available to copy the data on a CF card to

Hard Disk.

3. CF Card Manager
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E. Converting a BIN File back to the Original Format

All the data written to CF card has the same extension of [.BIN] after executing [B. Write to

CF card].  (See page 3-29.)

BIN files can be converted back to the original file format.

The following files can be converted.

Folder Extension after Conversion

BITMAP .bmp

CARD .mcd (for M-CARD SFT Editor)

DSP .V6

HDCOPY .bmp

MEMO .bmp

Procedure

1. Select the file to be converted.

2. Click [Put BIN File Back] from the [File] menu.

Or, right-click and select [Put BIN File Back].

3. The [Save As] dialog is displayed.

Select the location, give a file name,

and click [Save].

4. A file with ".BMP" extension is created.

3. CF Card Manager
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F. Others

BIN File Property
Select a BIN file, right-click, and select [Property].  The file information is displayed.

<Example>

BMPxxxx.BIN/HDxxxx.BIN/MEMxxxx.BIN

The bipmap image is displayed.

DSPxxx.BIN

The file type, version number, etc. can be displayed on the [Detail] tab window.

The [File comment] entered at the time when [Write to CF card] is executed can be

displayed on the [General] tab window.

3. CF Card Manager
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